Beginner GPS Training for Natural Resource Professionals

Western Maryland Research and Education Center
Keedysville, Maryland

Jonathan Kays, Natural Resources Extension Specialist
Eli Hammond, Forestry Extension Assistant
in cooperation with John McGee, Virginia Geospatial Extension Program
www.cnr.vt.edu/gep

5 CFE Credits (Category 1) Society of American Foresters • 6 Master Logger Program Credits

Equal Opportunity Programs
### List of Contents

- List of Contents ................................................................. 1
- Agenda ................................................................................. 2
- GPS Introduction PowerPoint ............................................. 3
- GPS Activities PowerPoint .................................................. 14
- GPS Training Field Activity Sheets
  - Activity 1: Getting to Know the GPS Receiver ................. 20
  - Activity 2: Setting Up the GPS Unit ............................... 23
  - Activity 3: Waypoints, Routes, and Tracks .................... 26
  - Activity 4: Entering Coordinates and Finding Locations .... 33
  - Activity 5: Creating Waypoints Using the Map Feature ...... 38
- Using a GPS Receiver with Computer Software
  - USA PhotoMaps – Short Tutorial....................................... 40
  - Field Experience with GPS: Verifying Coordinate Data Using USAPhotoMaps Software ....................... 42
  - EasyGPS ........................................................................ 49
  - GPS Utility: A User Guide for Educators ....................... 51
  - Using GPS with Google Earth ........................................... 61
  - Terrain Navigator: A User Guide for Natural Resource Managers ......................................................... 64
- Other Resources
  - Common GPS Related Terms .......................................... 75
  - GPS Hardware and Software Resource List .................... 77
  - Web-Based GPS Resources ............................................. 79
  - MD Merlin ..................................................................... 80
Beginner GPS Training for Natural Resource Professionals

Instructors: Jonathan Kays, Extension Specialist – Natural Resources

In Cooperation with: John McGee, Virginia Geospatial Extension Specialist

Agenda:

8:30 Registration (Provide each participant a unit for workshop use and a training manual)

9:00 Introduction to GPS (Classroom instruction)

9:45 Getting to know the GPS receiver (Classroom instruction)

10:00 Activity 1: Getting to Know the GPS Receiver (Field Exercise)

10:15 Activity 2: Setting Up the GPS Unit (Field exercise)

10:30 Activity 3: Waypoints, Routes, and Area (Field exercise)

11:50 Activity 4: Entering Coordinates and Finding Locations (Inside activity)

12:00 Lunch

1:00 Activity 4 & 5: Mapping roads, boundaries and other features on timber sale. Creating waypoints using the mapping feature. (Field exercise)

2:30 Mapping and GPS Software: (Classroom instruction)
Download points from activities and work with software on computers.
- USAPhotoMaps (hands-on)
- Easy GPS (hands-on)
- GPS Utility (hands-on)
- Google Earth (hands-on)
- Terrain Navigator (demonstration by instructor)

3:45 Close
Welcome to the GPS Introductory Training
Your instructor:

Jonathan Kays
Natural Resources Extension Specialist
University of Maryland Cooperative Extension
jkevs@umd.edu

Intro to GPS Navigation
Bringing technology into the forest
(and helping you find your way out of it)

Jonathan Kays
University of Maryland Cooperative Extension
In cooperation with John McGee, Virginia Geospatial Extension Program

Objectives for Today
- Learn how to use the various functions of the GPS unit.
- Apply GPS to some field activities that you may use at work or play
- Encourage you to sign up for full-day course in October. Go to www.naturalresources.umd.edu

Outline
- Why GPS
- What is GPS
- How GPS works
- What you need to know about GPS
- What you can do with GPS
- Applications of GPS

Why GPS?
- There are many features that do not have addresses...especially in forestry!
- There are many cities that do not even have street names.
- Then there is the open ocean, sky, and of course...the forest!

Why GPS?
Location, Location, Location
And
INFORMATION!!
What Is GPS?

- GPS is not a single unit!
- GPS = Global Positioning System
- Developed by Dept of Defense at a cost of > $12 billion
- Funding was contingent on making the system available to the public

GPS is a SYSTEM

There are three major components in this system:
1. Satellites
2. Ground Control Stations
3. GPS Receivers (or units)

Satellites

- There are 24-32 satellites up there at any given time orbiting the earth at ~11,000 nautical miles.
- The DOD knows the exact location of each.
- These satellites have very accurate clocks.
- The satellites continuously send radio signals towards earth.
- These radio signals are picked up by GPS receivers.

Control Stations

- There are five control stations that monitor the satellites.
- Control stations enable information on Earth to be transmitted to the satellites.
- Control stations continuously track satellites, and update the positions of each satellite.
- Without control stations, the accuracy of the system would degrade in a matter of days.

GPS Receivers

- GPS units are referred to as "receivers".
- They receive information (radio signals) from satellites.

GPS Receivers

- The GPS receiver knows how long it takes the signal to travel from the satellite to the receiver.
- The receiver is therefore able to calculate its exact distance from the satellite.
  - Distance = speed x time
  - Distance = time x 186,000 miles
How GPS Works

• GPS uses trilateration (compare to triangulation)
  – You can find any point if given distances from 3 other points
  – Actually need 4 points with GPS

Simplified Trilateration

One satellite tells you that you are 20 miles from Frederick, Maryland.

If the GPS receiver obtains two satellites, it tells you that you are also 20 miles from Baltimore.
A third satellite tells you that you are 20 miles from Washington DC.

A fourth satellite is required to determine exact location and elevation.

How GPS Works

If the GPS obtains signals from 3 satellites, then it "knows" that it is located somewhere where these 3 spheres intersect (2 points).

How GPS Works

A fourth satellite is required to determine the exact location and elevation.
Different “Grades” of GPS receivers:

- **Recreational Grade GPS** – $100-$300
  - Accurate to within 5 meters (possibly better)
  - Suitable for hunting, recreational and some business uses

- **Mapping Grade GPS** – $5,000-$10,000
  - Accurate to within 1 meter (3 feet)
  - Suitable for many natural resource applications, city planning

- **Survey Grade GPS** – $20,000
  - Accurate to within 1 cm, suitable for building bridges...

What you need to know about GPS:

- Signal Accuracy Issues
- Selective Availability
- Tricks of the Trade
- Current Applications of GPS
- Future Applications of GPS

Signal Accuracy

There are 2 types of GPS Signals:

- **P-code ("Precise" code):**
  - This is only available to the military and some selected public officials.
  - Very precise, not degraded

- **C-code ("Civilian" Code):**
  - Less precise
  - Signal can be degraded by scrambling the signal, especially in times of conflict.
  - This is what the GARMIN GPSMAP76 (and all public GPS receivers) work with...

Selective Availability (SA)

- For national security reasons, the military sometimes degrades the C-code signal. This is called selective availability.
- These errors are random
- Errors be as high as $+300$ feet

Selective Availability

- SA errors can put you on the wrong side of a stream, or even a different city block or street!
- $300$ feet is a lot of real estate!!!

The GPS tells you that you are located here...

But your real location is here...

Selective Availability

- It is possible to correct for Selective Availability (as well as other inherent signal errors).
- However, SA has not been employed for many years. If it was, there would be media attention since it would affect car GPS systems and many others.
Differential Correction

- In general, GPS made more accurate by process called Differential Correction
- Here's how it works...

Differential Correction

- There are already established base stations around the U.S.
- Surveyors have determined the precise location of these base stations already.
- Each base station has a GPS receiver, which collects incoming (scrambled) signals.
- The true (surveyed) location is then compared to the GPS coordinates.
- The correction values are then sent back to the person sending the original coordinates.

Differential Correction

- The Wide Area Augmentation System (WAAS) is a differential GPS system that is being constructed to support GPS accuracy in aircraft.
- WAAS also provides additional accuracy “on the ground” but only if you are in the open.
- The GPS receivers that we are using are WAAS compatible

WAAS Satellites

- Historically, some areas have had trouble acquiring the WAAS satellites because only two.
- A new WAAS satellite was launched in the Fall 2006.
- Better coverage for Mid-Atlantic and higher accuracy levels

WAAS

- Other Tricks of the Trade: Averaging
  - Averaging: A GPS receiver can collect points continuously for 15-30 seconds. The receiver can then average all these locations together.
  - This only works when you are standing still!!
Other Tricks of the Trade: Satellite Distribution
- It is better for your receiver to get a fix on "distributed" satellites, than poorly distributed satellites.

Other Tricks of the Trade: MultiPath Errors
Try and stay away from buildings and other structures when using a GPS receiver. Satellites may not be visible. This can introduce errors.

Other Tricks of the Trade: Tracking Satellites
GPS has worldwide coverage...

HOWEVER...
You can lose satellite coverage (or received degraded signals) in areas with dense foliage, in "urban canyons", etc.
You may also lose satellite coverage (or receive degraded signals) in deep valleys or gorges.

Accuracy depends upon...

What can you do with a GPS?
- Collect and store points (positions) These are called WAYPOINTS. Field corners, insect infestation areas, crop damage, individual trees, trail heads, creek crossings, point source pollution, etc.
- Download the points onto your computer and integrate them with other mapping programs.
What can you do with a GPS?

- Collect and store the path that you have walked/driver.
- These paths are called TRACKS.
- Calculate the distance of a track (i.e., perimeter around a field).
- Calculate AREA measurements within a TRACK (after walking around a field).
- Save and Download TRACKS onto your computer.

Tracks (just start walking...)

What can you do with a GPS?

- Collect and store ROUTES.
- Routes are similar to TRACKS, but are created by Waypoints.
- Routes can be handy for measuring "square fields" and "straight lines."
- You can measure the length and area (acreage) of a Route.

Routes

What can you do with a GPS?

- The GOTO function. Using the 'GOTO' function, the GPS will guide you to a predefined Waypoint (you choose which one...) using a compass and "pointer."
- The GOTO/FIND function is like using "Autopilot". You can program the GPS to "beep" when you are within a certain distance of a selected Waypoint.
Other Things You Can Do with a GPS:
- Sunrise/Sunset - tide table
- Games-Calculator-Datebook-Stopwatch
- Ground Speed - walk, run, drive, or fly
- Distance traveled
- Estimated time of arrival
- Elevation - accuracy can vary widely

What can you do with a GPS?
- Measure Area / perimeter
  - Foresters - loggers can measure the area of a timber sale.
  - Farmers can use a GPS to measure the area of a pasture or a field of corn.
  - Measure acreage of an area to be planted in the field.

Current Application Areas of GPS
- Public Safety
- Environmental resource management
- Aviation
- Military
- Local planning
- Surveying
- Recreation
- Business

Future of GPS
- More satellites (American, European, Russian)
- More accurate units at lower cost - look for new "SIRF" chip in units. Works under worst of conditions.

The Future is bright...
- The DoD is in the process of upgrading the existing GPS satellite constellation
- A new WAAS satellite provides:
  - Better coverage availability (i.e. in forested areas)
  - Anticipated greater accuracy (even for recreational grade GPS receivers)

GPS accuracy will only get better...
- Starting in 2009 we will be able to access 12 European satellite system which will greatly increase the number of satellites.
- European satellites are also more accurate than many of ours.
- Russia is also launching new satellites.
The Future is bright...
- The DoD is in the process of upgrading the existing GPS satellite constellation
- A new WAAS satellite will be launched in Fall 2006
  - better coverage availability (i.e. in forested areas)
  - anticipated greater accuracy (even for the recreational grade GPS receivers)

GPS accuracy will only get better...
- Starting in 2009 we will be able to access 12 European satellite system which will greater increase the number of satellites.
- European satellites are also more accurate than many of ours.
- Russia is also launching new satellites

GPS Receivers
- Continue to get better and better
  - better antennas,
  - more efficient power consumption,
  - smaller
  - increasingly more "bells + whistles" (maps, hard drives, etc.)
  - inexpensive

Purchase Considerations
- Physical attributes:
  - Size
  - Weight
  - Waterproof
  - Battery life
  - Screen: color or black & white
- WAAS enabled: for accuracy under cover
- Memory – internal and expandable

Purchase Considerations
- SiRF chip (x in name) – faster fix times, more sensitivity for receiving signals under forest cover, and longer battery life
- Mapping software
- 2-way radio capability
- Price

The applications are endless
GPS Receivers
- Continue to get better and better
  - better antennae,
  - more efficient power consumption,
  - smaller
  - increasingly more "bells + whistles" (maps, hard drives, etc.)
  - inexpensive

Purchase Considerations
- Physical attributes:
  - Size
  - Weight
  - Waterproof
  - Battery life
  - Screen: color or black & white
- WAAS enabled: for more accuracy in the open
- Memory – internal and expandable

Purchase Considerations
- SiRF chip – faster fix times, more sensitivity for receiving signals under forest cover, and longer battery life
- Mapping software
- 2-way radio capability
- Price

Things to remember...
- GPS can serve as an accurate data collection tool for GIS applications;
- GPS applications are becoming increasingly prevalent in our society, and support a variety of applications;
- With GPS receivers, you (more or less) get what you pay for (with prices ranging from $20,000+ - $59)
- Knowing how to use a GPS does not make you a surveyor!

What it's not...
Perfect
GPS Workshop Activities

Bringing technology into the forest
(and helping you find your way out of it)

Jonathan Kaye
University of Maryland Cooperative Extension
In cooperation with John McGee, Virginia Geospatial Extension Program

Outline

- Activity 1 – Getting to know the GPS
- Activity 2 – Setting Up the GPS Unit
- Activity 3 - Waypoints, Routes, & Tracks
- Activity 4 – Entering coordinates and finding locations
- Activity 5 – Creating waypoints using the map feature
- Downloading data to & from computer

Why GPS?

Location, Location, Location
And
INFORMATION!!

Garmin GPSMap 76Cx

- Color screen
- New x chip enables use under heavy forest canopy
- 128 mb card
- WAAS capable
- Water resistant
- Floats
- $479 list (available for about $300 online)

Activity 1
Getting to Know the GPS Receiver

- Familiarize yourself with the different screens and buttons
- Find out how to get basic information (location, elevation, speed)
- Using the Menu button

What Do The Letters Mean?

- GPSMAP76 is the type of unit
- “C” stands for color
- “S” stands for sensors (compass and barometric altimeter). Units have one extra screen compared to “C” model.
- “X” stands for expandable memory slot. The “X” models also happen to have the SIRF chip but that is not “X” stands for.
Using the keypad

Welcome Screen

Satellite Acquisition Screen

If the unit cannot get a satellite fix...

• You can still use the unit with the GPS off.
Trip Computer

- How far you have traveled
- Max and average speed
- Time moving & stopped
- Elevation

Map

- You are the black arrow which points in direction of travel
- You can zoom in and out
- Scale is in lower left corner
- Unit comes only with basic road system

Compass

- If moving compass will swing to show direction.
- It points in direction you are going, not north.
- If GOTO option is activated, red arrow will show direction of desired waypoint

Main Menu

- Get to this screen anytime by pressing MENU button twice
- Setup option provides way to change defaults

Activity 1

- Outside
- 20 minutes
Activity 2
Waypoints, Routes, and Tracks

- Mark locations you want to map or return to such as a logging road, property boundary, high quality timber
- Find your way from one waypoint to another
- Track your path and calculate area within a boundary

Map Screen

Creating a Waypoint
- Zoom in and out as needed to get proper scale
- Hold down ENTER button for a couple of seconds to mark waypoint.

Main Menu

- Press page button to take you to the Main Menu (or press MENU twice).
- Push right side of rocker to highlight Routes and press ENTER

On-screen buttons

Highlighted field

Highlight field

Route Screen

- You can add many waypoints to create a route that you can then follow.
Activity 2 - Project C
Finding Distance of a perimeter and its area using the tracks

- Tracks – “breadcrumbs” marking where you’ve been
- Area Calculator – automatically finds area of space you’ve outlined with tracks

Main Menu

- Go to the MENU screen and use the rocker to highlight tracks and press ENTER
- We will then follow the directions on the activity sheet

Tracks

- Clear any previous tracks by highlighting CLEAR and pressing ENTER
- Be sure the radio button is “on” and continue with the skill.

Activity 2

- Outside
- 45 minutes
- When finished, come back inside

Activity 3
Entering Coordinates and Finding Locations

- Enter latitude/longitude as a waypoint
- Have the unit direct you to the area
- Set up a route to guide you around the boundary

Entering Coordinates

- Create a waypoint – it doesn’t matter where you are
- Change the “Location” by entering lat/long coordinates
- Get directions to the new waypoint by pressing “FIND”
Create a Route – Find the Sale Area perimeter

- Using the five waypoints you entered, create a route using the direction
- Go outside and go to your first waypoint
- Start a new track
- Start your route
- Calculate the area of the sale
- Take waypoints on road location & tree

Computer Software Free

- USAPhotoMaps – free
- Google Earth – free
- EasyGPS – free
- GPS Utility – free

Computer Software - Purchase

- Terrain Navigator from MapTech - $99.95/state
  - Digital USGS quads essential for forestry
  - Mid-Atlantic package one state (MD, DE, NJ, DC)
- Terrain Navigator Pro - $300/state
  - Same as above with aerial photo access and overlay.
- MapSource TOPO 2005 from Garmin - $100
  - 1:100,000 scale, detailed roads and cities, points of interest, etc. Really good for road travel and basic topography on the GPS unit.
Activity 1: Getting to Know the GPS Receiver

Turn the unit on by holding down the Power button (red circle with vertical line) for two seconds.

After the welcome screen, the Satellite screen will appear and it will briefly read “Acquiring Satellites” at the top. If you are out in the open, it should only take a short time to acquire enough satellites to make out your location.

If the unit cannot get a satellite fix, an options menu with a list of solutions will appear (picture 1). Highlight the appropriate option and press ENTER.

The large, outer circle represents the horizon; the inner circle is 45 degrees in from the horizon (picture 2). The gray and red circle on the outer circle represents your direction of travel.

Which numbered satellite is most closely overhead? __________

How many satellites are being received by your GPS receiver? __________

What is the accuracy indicated by your receiver? +/- __________
Pressing the PAGE button will allow you to cycle through the following five screens:

<table>
<thead>
<tr>
<th>Satellite</th>
<th>Trip Computer</th>
<th>Map</th>
<th>Compass</th>
<th>Main Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Satellite Screen" /></td>
<td><img src="image2.png" alt="Trip Computer Screen" /></td>
<td><img src="image3.png" alt="Map Screen" /></td>
<td><img src="image4.png" alt="Compass Screen" /></td>
<td><img src="image5.png" alt="Main Menu Screen" /></td>
</tr>
</tbody>
</table>

While on the **Trip Computer** screen (picture 5), what does it say is your elevation? __________

Go to the **Map** screen (picture 6). Zoom in and out using the IN and OUT buttons.

When zoomed all the way out, what is the scale of the map? __________
When zoomed all the way in, what is the scale of the map? __________

Go to the **Compass** screen (picture 7) and walk around. Notice how your speed and direction change.

What is your approximate rate of speed? __________

On the **Main Menu** screen (picture 8), use the rocker to highlight **Sun & Moon**; press ENTER.

What time was sunrise this morning? __________

Use the rocker to highlight the **play button** (single right-facing arrow) (picture 9). Press ENTER to view the movement of the sun and moon today. Highlight **fast forward** (double arrow) and press ENTER to view the changes in high speed. Watch how the phases of the moon change over time.

On the **Main Menu** screen, use the rocker to highlight **Hunt & Fish**; press ENTER.

What are the best times to hunt or fish today? __________
The Wide Area Augmentation System (WAAS) can be accessed to improve the integrity of the GPS signal (the system is called EGNOS in Europe).

- Press MENU twice to get to the Main Menu. Highlight **Setup** and press ENTER.
- Highlight **System** and press ENTER (picture 10).
- Highlight the **WAAS/EGNOS** box and press ENTER (picture 11).
- Highlight **Enabled** and press ENTER. Your unit will now pick up WAAS signals, if available.

Press QUIT twice to go back to the Main Menu. (Or, from any screen, you can press the MENU button twice to return to the Main Menu screen.)

If you would like to use your GPS unit to guide you while driving on highways, you will want the routing to guide you along roads, rather than as the crow flies.

- Highlight **Setup** and press ENTER.
- Highlight **Routing** and press ENTER (picture 12).
- Highlight the **Guidance Method box** and choose **Off Road** since we will be walking off road today (picture 13).

The MENU button brings up different menus depending on the screen. You may want to experiment with this on your own to explore the many options on various screens.

Press PAGE to get to the **Trip Computer** screen. Press MENU once (picture 14).

What are your first two options? ____________________

If you do not wish to make changes, you can press the QUIT or MENU buttons to return to the previous screen or Main Menu.
Activity 2: Setting Up the GPS Unit

Before going out to use your GPS unit in the field, you may want to change some of the settings. The following instructions are for changing the tracks, tone, on/off road, and compass settings.

Tracks
When tracks are on, a location data point is recorded intermittently, creating what look like breadcrumbs marking the path you have taken. Tracks can be set to record a “breadcrumb” at intervals based on time or distance. If you are traveling slowly or have stop along the way, you may want to record based on distance rather than time, so that there are not several breadcrumbs recorded for the same spot.

- Press MENU twice to return to the Main Menu.
- Highlight Tracks and press ENTER (picture 1).
- Highlight Setup and press ENTER (picture 2).
- Highlight Record Method and press ENTER (picture 3).
- Highlight your selection and press ENTER.

If you chose Distance or Time, you will be able to change the interval between recordings.
- Highlight the Interval box and press ENTER.
- A number pad screen will appear and you can specify the time or distance interval (picture 4).

By checking the box labeled Wrap When Full, the GPS unit will record over old tracks when the memory assigned to tracks becomes full. If you do not want old tracks erased, un-check this box by pressing ENTER.
**Tone Setup**
There are a variety of options for changing the tones produced by the GPS unit.

- Press MENU twice to get to the Main Menu.
- Highlight **Setup** and press ENTER.
- Highlight **Tones** and press ENTER (picture 5).
- Select which tone volume you would like to change and press ENTER (picture 6). The higher the tone number, the louder the beep.
- If you would like to mute all tones, highlight **Mute** and press ENTER to check or un-check the box (picture 7).

![Tone Setup](image)

**On/Off Road**
If you will be traveling through the woods, on trails, or on roads that are not mapped in your GPS unit, you will want it set to off road so that instructions are not given using roads.

- Press MENU twice to get to the main menu.
- Highlight **Setup** and press ENTER (picture 8).
- Highlight **Routing** and press ENTER (picture 9).
- Highlight the box under **Guidance Method** and press ENTER (picture 10). You will be given the choices Follow Road, Off Road, and Prompted.
- Highlight **Off Road** and press ENTER (picture 11).
Compass Heading
Most GPS units do not have an electronic compass, so the compass directions only work when you are moving. (Garmin units with an “S” in the name, such as the GPSmap 76CSx, do have an electronic compass.) You can change the compass settings based on true north, magnetic north, or a grid set to the degree variation you specify.

- Press MENU twice to go to the Main Menu.
- Highlight Setup and press ENTER.
- Highlight Heading and press ENTER (picture 12).
- Highlight the North Reference box and press ENTER. Select your preference and press ENTER (picture 13).
- If you would like to specify the degree of magnetic variation, highlight User and press ENTER. Then, highlight the Magnetic Variation box and press ENTER (picture 14). A number pad screen will pop up. Enter the desired value, highlight and press ENTER (picture 15).
Activity 3: Waypoints, Routes, and Tracks

PROJECT A: Waypoints

Waypoints are pinpointed locations that are stored in a GPS unit. They are used to mark places or in creating routes. You can create waypoints on your GPS unit or on a computer and transfer them.

Deleting Waypoints

Before starting this activity, you may want to clear previous waypoints that have been saved on your GPS unit.

- Press FIND. Select **Waypoints** and press ENTER (picture 1).
- If there are waypoints listed and you want to delete them all, press MENU and select **Delete**… (picture 2).
- On the screen that appears, select **All Symbols** and press ENTER (picture 3).
- A box will now come up asking if you really want to delete all waypoints. Select **Yes** and press ENTER (picture 4).

If you only want to delete one waypoint, press FIND. Select **Waypoints** and press ENTER (picture 1).

- Highlight the waypoint you want to delete and press ENTER (picture 5).
- Highlight **Delete** and press ENTER (picture 6).
- A box will now come up asking if you really want to delete the waypoint. Select **Yes** and press ENTER (picture 7).
Creating New Waypoints

- Go to the Map screen. Zoom in all the way by pressing the IN button several times. Walk around. In the upper left corner of the screen, a compass arrow will point north (picture 8).
- Stop somewhere and create a waypoint by pressing and holding ENTER until the screen changes to show the "Mark Waypoint" screen (picture 9). This screen allows you to change the name of the waypoint and shows information about it such as when it was created and the location.
- Change the name of this waypoint by highlighting the name box at the top of the screen and pressing ENTER. Using the rocker and enter button, name this waypoint End. When you are finished, highlight OK on the letter/number screen and press ENTER (picture 10).
- You can change the symbol for any waypoint by first highlighting the flag at the top of the screen (picture 11). Press ENTER and choose the red flag symbol from the Markers screen (picture 12).
- Once you have chosen the symbol, highlight OK at the bottom of the screen and press ENTER. The new symbol will appear on the map where you created the waypoint.
- Walk about 30 yards away and create another waypoint named Start. Give this waypoint a green flag symbol. Stay at this second waypoint and begin Project B.

Averaging a Waypoint

To obtain a more accurate location for your waypoint, you can have the GPS receiver take several measurements at the same location. It will then average these measurements to provide a better estimate for the coordinates for your specific location.

- Create a waypoint for your current location by holding ENTER.
- Highlight Avg (picture 13) and press ENTER.
- A new screen will appear showing the waypoint information. At the bottom of this screen, you will see the Measurement Count number.
increasing about every second (picture 14). The Estimated Accuracy number should decrease as more measurements are taken.

- When you are satisfied with the estimated accuracy, highlight **Save** and press ENTER. This will save the averaged waypoint just like any other waypoint.
- NOTE: Remain still as the GPS unit is taking measurements. You will have better accuracy if you are away from large objects like buildings or large trees, and if there is little or no overhead cover.

Application – You can use the waypoint function to mark and name roads, property boundaries, stream crossings, buffer areas, logging deck location, access points, tree locations (specimen trees), and high quality timber. Use the Average Waypoint function when you need a more accurate location and can remain at a marking location for a few seconds.
PROJECT B: Routes
*Use the Routes feature to obtain directions between waypoints you created.*

- Press MENU twice to return to the main menu page. Use the rocker button to highlight **Routes** and press ENTER. Highlight **NEW** on the bottom of the screen and press ENTER (picture 15). Press ENTER to “Select Next Point” (picture 16).
- On the next screen, highlight the **Waypoints** icon and press ENTER (picture 17). Using the rocker, highlight the waypoint marking your starting position (Start waypoint) and press ENTER (picture 18). On the Waypoint page that popped up, highlight **Use** and press ENTER (picture 19).

Now your starting waypoint should be listed on the Route screen.

- Again, highlight **Select Next Point** and press ENTER (picture 20). Highlight the **Waypoints** icon and press ENTER.
- Now highlight the End waypoint, and press ENTER (picture 21). Highlight **Use** in the lower right hand corner of the screen and press ENTER.

Now your two waypoints should be listed in the Routes page.
Highlight **Navigate** and press ENTER (picture 22). The map screen will appear, showing your current location marked by a black arrow (picture 23). The top of the screen will instruct you which direction to travel. Refer to the North cardinal arrow to help orient yourself.

Follow the on-screen instructions, moving toward your destination. When you get within about 30 feet of the End waypoint, the unit will beep and read “Arriving at End.”

When you are finished navigating, be sure to **turn off navigation**. If navigation is left on, you may have trouble using other functions of the GPS unit. Turning navigation off can be done several ways.

- From the compass screen, press MENU. Select **Stop Navigation** and press ENTER (picture 24).
- From the map screen, press MENU. Select **Stop Navigation** and press ENTER (picture 25).
- From the routes screen, highlight **Stop** and press ENTER (picture 26).

**Application** – You can enter waypoints in a GPS unit and give it to coworkers, buyers, etc. to find their way to an access point or a corner of a timber sale. The waypoints for property corners or timber sale boundaries can be entered into a route so people can navigate around the perimeter.
Project C: Finding Distance of a Perimeter and its Area Using the Tracks Option

Use this function if you are walking/driving along the boundaries of location and want to find its area.

- Go to the Main Menu page by pressing MENU twice. Highlight the Tracks icon and press ENTER.
- Make sure Track Log is on by highlighting On and pressing ENTER (picture 27).
- To clear any past tracks, highlight Clear and press ENTER. On the popup screen asking if you really want to clear the track, highlight Yes and press ENTER.

- Now walk around the perimeter of the building. When you come back to your starting place, highlight Save and press ENTER. On the popup screen asking if you want to save the entire track, highlight Yes and press ENTER.

Now the Saved Track screen will come up. It shows information about the track like the distance and area inside the track.

- Highlight the Name and press ENTER to bring up the alphabet screen. Rename your track “Building.” Highlight OK and press ENTER (picture 28).

What is the distance you traveled around the building? __________

What is the area of the space you walked around? __________
There is another way to calculate the area of a property:

- While on the Tracks page, press MENU. Highlight **Area Calculation** and press ENTER (picture 29). A map screen will appear with **START** highlighted at the bottom of the screen (picture 30). Press ENTER to begin tracking your movement.
- Walk around, making a large circle or rectangle (about 100 or more paces), and when you get back to your starting point, highlight **STOP** on the tracking page and press ENTER.

*You should be able to see the shape you made as outlined by the tracks (dots on the map)* (picture 31).

At the bottom of your screen, you will see the area of the space you outlined. You can change the units by highlighting the units and pressing ENTER (picture 32). The options are square feet, \( \text{ft}^2 \), square yards \( \text{yd}^2 \), square meter \( \text{m}^2 \), acre \( \text{ac} \), hectare \( \text{ha} \), square kilometer \( \text{km}^2 \), square mile \( \text{mi}^2 \), and square nautical mile \( \text{nm}^2 \).

What is the area of the space you walked in square yards? _________

**Application** – Quickly find the area of a timber sale by walking or driving along the boundary while using the area calculation function.
Activity 4: Entering Coordinates and Finding Locations

Below are the coordinates for the corners and road entry location for a proposed timber sale area. You will enter the coordinates in your GPS receiver, then find this place outside.

Corner 1: N 39°30.663' W 077°43.895'
Corner 2: N 39°30.720' W 077°43.868'
Corner 3: N 39°30.742' W 077°43.921'
Corner 4: N 39°30.699' W 077°43.939'
Corner 5: N 39°30.670' W 077°43.929'

To enter latitude/longitude coordinates, you must first create a waypoint. This can be done anywhere – you don’t need a GPS signal.

- Create a waypoint by holding down ENTER. Give the location a name by highlighting the upper box next to the blue flag and pressing ENTER (picture 1). An on-screen keypad will pop up. Use the rocker to enter a name for your first point (highlight a letter and press ENTER after each letter/number selection). You may want to name the waypoints Corner 1, Corner 2, etc. When you are finished entering the name, highlight OK and press ENTER (picture 2).
While still on the Waypoint screen, use the rocker to highlight Location and press ENTER (picture 3). Using the on-screen number pad, enter the Latitude and Longitude coordinates you were given for the first point (picture 4). Highlight OK and press ENTER.

Repeat these steps, creating a waypoint for each corner of the timber sale and for the road entry point – name this waypoint Road 1.

Now make a route that will lead you around the boundaries of the timber sale.

Press MENU twice to go to the Main Menu screen.
Highlight Routes and press ENTER.
You want to create a new route, so highlight New and press ENTER (picture 5).
You will now begin to select points along the route to help you navigate. Highlight Select Next Point and press ENTER (picture 6).
Since you have entered the points as waypoints, highlight Waypoint and press ENTER (picture 7).
Highlight the waypoint marking the first corner and press ENTER. The Waypoint screen will come up. Highlight Use and press ENTER (picture 8).
Now you'll need to choose the next waypoint. Highlight **Select Next Point** and press ENTER. Select the next corner waypoint. Continue selecting the remaining Waypoints as before to complete your route.

Your last waypoint should be the same as the first timber sale waypoint, so you'll be led back to your starting place to complete the boundary.

Now you will travel to the first corner of your route. You will need to obtain a GPS signal if you have not already.

Press FIND. Highlight **Waypoints** and press ENTER (picture 9). Highlight the waypoint that is the first location in your Route. Press ENTER. On the Waypoint screen that comes up, highlight **Go To** and press ENTER (picture 10). The map screen will come up (picture 11). Follow the directions leading you to the proposed timber sale.

Press PAGE to go to the Compass screen (picture 12). The compass arrow will direct you in which way you should travel. If you are traveling in the correct direction, the “Dist to Next” number will decrease as you get nearer your destination. When you get close to your selected waypoint, your GPS unit will beep and the message “Arriving at ___” will appear (picture 8).

You can follow the directions on the map or compass screens. Press PAGE to switch between views. Use whichever one you are more comfortable with.

When you reach the first waypoint and are ready to start your route, set up Tracks to mark your movement.
Tracks will allow you to find the distance of the perimeter and the area of the potential timber sale.

- Press MENU twice to go to the Main Menu. Highlight **Tracks** and press ENTER. Make sure the Track Log is **On** (picture 13) and Clear the track log by selecting **Clear** and answering **Yes** on the popup screen (picture 14).

Now begin navigating your way along your route.

- Press MENU twice to go to the main menu screen. Highlight **Routes** and press ENTER. Select the route you created and press ENTER. Highlight **Navigate** and press ENTER (picture 15). The map screen will come up and directions will appear at the top of your screen (picture 16).

You can view your progress on different screens. Press PAGE to go to the Map screen. Follow the purple line to your next waypoint. Press PAGE again to get to the Compass page. The red arrow will tell you which direction to travel. As you approach a waypoint, the unit will beep. Once you reach a waypoint, you will automatically be directed to the next waypoint.

When you get back to your starting point, go to the Main Menu, then to the Tracks page and select **Save** and select **Yes** on the popup screen (picture 17). The Saved Track screen will come up providing information of the track you just traveled along your route (picture 18).

- What is the distance you traveled? _______
- What is the area of the timber sale in acres? _______
Go to the road entry point. Create a new waypoint here and name it Road 1.

- Enter the woods at this waypoint and find the flagged cherry tree. Create a new waypoint there and name it Cherry.

**Application** – You can provide coordinates for access points, key property corners, and other features on a timber sale bid so potential buyers or work crews can find and navigate the sale area more easily on their own. Mark points for a future logging road, harvest location, tree planting area, or spray location and give the GPS unit to the work crew to carry out needed tasks.
Activity 5: Creating Waypoints Using the Map Feature

A) Create waypoints without going to the location or knowing the coordinates.

- Go to the Map screen. Zoom in or out so that you can easily see the local roads.
- Using the rocker, move the arrow to where the entry gate to WMREC is located on Keedysville Road. Press ENTER. If there is no information known for that spot, a message will come up asking “Do you want to create a user waypoint here?” (picture 1) Highlight Yes and press ENTER. You have now created a new waypoint (picture 2).
- If there is information about that spot saved in your GPS unit, a nametag will appear when your arrow is over it (picture 3). If you press ENTER to create a waypoint, it will automatically be named using the saved information (in this example, the point has been automatically named “Road”). You must select Save (picture 4) to keep it saved as a waypoint.
- If you select Go To (picture 5), you will be given directions on the map screen to get there from your current location. If you choose Map (picture 6), the map screen will appear, showing the location of the new waypoint.

Application: - Use this function when you want to create a waypoint for a place you can find on a map but don’t have its exact coordinates.
B) Starting from a known point, follow an azimuth and distance to a new location and create a new waypoint.

➢ To create waypoints on the GPS unit using azimuth and distance, you will need to have a starting waypoint saved in the unit or be at a known point.

To create a waypoint a certain distance and bearing from a saved or newly created waypoint, press FIND and select a starting waypoint. Press MENU once. Select Project Waypoint and press ENTER. At the bottom of the screen, a box will be labeled “From ...” naming first waypoint you selected.

By highlighting and pressing ENTER, you can change the bearing and distance. To change the distance units, highlight the current unit (miles (mi) is the default) and press ENTER. Once you enter the azimuth and distance, the latitude and longitude will automatically change to the correct coordinates for that location. Rename the waypoint and select Map. The new waypoint will be automatically saved. You can see the new waypoint on the map screen.

When you are ready to create the next projected waypoint, press FIND, select the waypoint you just created, and proceed with the same process. This method allows you to make waypoints. If you want to make a route out of these waypoints, you can do that by creating a route and adding each point in order.

Application – Going to a new location using the GPS map can be used to find the shortest route to a road, stream, building, or other location. If there is a medical emergency you can alert responders to the best access point and provide a latitude-longitude location.

Following a distance and azimuth to a new waypoint is very useful for finding the boundaries of a property for which you have a survey. Most survey measurements are bearings so you will have to convert from bearing to azimuth (0-360 degrees).
When you open the USAMaps program, a black and white aerial photo of the reflecting pool in Washington DC comes up.

The Menu bar at the top of the screen has the following options: File, Zoom, GoTo, Zoom, Scroll, Text, Route, Waypoints, GPS, and Help.

If you are viewing an area for the first time, there may be gray boxes instead of photos or topo maps. To download photo or map images, press F. Once downloaded, they are saved on your computer.

To view topographic maps, press T, or click View on the menu bar. Select Map Type > Topographical Maps.
To view black and white aerial photographs, press P.

To connect a GPS unit, click GPS. On the dropdown menu, choose Baud. Select 9600. Then, on the GPS dropdown menu, choose Protocol. Select Garmin USB. You should now be able to transfer to and from the GPS unit. If you have not already done so, connect GPS unit to the computer via the USB cable turn the unit on. Once your unit is correctly connected, you should see a check mark next your unit in the Protocol list.

To transfer data, go to the GPS dropdown menu. Choose Route > Receive. A “Transfer Complete” message box will appear on your GPS unit. Transfer your waypoints and tracks the same way.

To see your waypoints, click on Waypoints in the menu bar. Click on “Show current...” Select a waypoint from the window that pops up and click “GoTo.” Your waypoints should show up as green dots.

To print from USAPhotoMaps, select File > Print. A message will appear reminding you to set your printer preferences to Landscape Orientation (you will not be able to print without changing to landscape). Everything showing on the map (routes, waypoints, etc.) should show up in the printout.

Create a new waypoint by clicking anywhere on the map where you want the waypoint located. A window will come up which allows you to write a description or note (Comment) about the waypoint and give it a name.
Create a route by clicking Route > Create. An information window will appear; click OK. On the map, click where you want to start your route and a line will follow your cursor. Click where you want the next point to be, and the line will remain between those points. Continue in the same manner to create a complete route. To end the route, double click on what will be the last point of your route. A window will appear asking if you want to save your route. Select Yes. A window will come up allowing you to name and save your route as a text (.txt) file. Once saved, you can send the route to your GPS unit.

To send a route to your GPS unit, in the menu bar, click on GPS > Route > Send. Select the route you created and click Open (see picture below). The route will now be on your GPS unit for you to navigate or map.
Field Experience with GPS: Verifying Coordinate Data Using USAPhotoMaps Software

Prepared by: The Virginia Geospatial Extension Program

**Background:** USAPhotoMaps requires that the user understand and know how to operate a GPS unit, and organize and collect field data associated with each GPS unit. This software enables users to download GPS WayPoints (or tracks) from their GPS receivers onto their computer, and to superimpose the collected data on top of aerial photographs. USAPhotoMaps prompts the user for a single WayPoint (for reference purposes). The software then “goes out” onto the Internet (i.e. Terraserver) finds the appropriate digital image associated with the user defined Waypoint, and downloads this digital photograph onto the user’s computer. The user can then superimpose collected WayPoints onto the image, or digitize new WayPoints on the image, and download them onto the GPS. The user should be aware of the limitations of USAPhotoMaps. This software only accesses aerial photography from Terraserver, which is primarily an archive of USGS imagery. These aerial photographs are a bit dated (the majority of the photographs for Virginia date back to the mid 1990’s). None of Virginia’s high resolution BaseMapping Imagery (VBMP) is accessible through this software. b. Reboot your computer (not always necessary, but it has made a difference before!).

**2. Collect GPS WayPoints, Tracks, etc.**

Head out into the field and have some fun. Refer to The Garmin Etrex Legend: An Introductory Handbook for Extension Agents or the Garmin Owner’s Manual...

**3. Download the GPS Data onto a Digital Aerial Photographic Map**

This involves 2 steps: Step 1: “Initializing, downloading, and opening” the Digital Photographs; Step 2: Downloading your GPS points on top of a digital aerial photograph (this is what the software is all about!) This manual will walk you through the two steps listed above...

**Getting Started... Before you can actually get started using USAPhotoMaps, you need to do a few things...**

1. Setup and Install USAPhotoMaps software
First, start with Step 1:

A. Logon to your computer
B. Start the USAPhotoMaps program. You should see a window like this appear on your computer screen:

![Screenshot of USAPhotoMaps program](image)

C. This dialogue box below is prompting you for some basic information so that it can find the appropriate aerial photographs…

![Dialogue box](image)

1. Enter a name for your map
2. Now you need to enter the initial Latitude and Longitude coordinates from your GPS (a waypoint coordinate from your GPS…)  
   ✓ Latitude is associated with either north or south,  
   ✓ Longitude is associated with either east or west.  
   ✓ Enter these values in the dialogue box. NOTE: In the United States, Longitude Degree Values should have a negative sign in front of them as shown in the example (your values will differ from the values in the example but your longitudinal degree value must be negative) if you are in the U.S.

3. Press the <OK> button on the bottom of the New Map Dialogue Box. Your coordinates have now been stored.

4. Select the <file> menu, select <Download Map Data> and <Fill Screen> (see figure below)

5. Your map should draw in the window. This could take some time if you have a slow internet connection…

The Virginia Geospatial Extension Program
6. Zoom into your map if you can by going to the <Zoom> menu, and select <zoom in>
Now you are ready for Step #2:
Downgrading your GPS points on top of the Digital Photographs.

Note: These instructions are for Garmin GPS receivers. If you are working with a different brand or model, your instructions, you should refer to the “official” instructions for USAPhotoMaps located in the Program Files/USAPhotoMaps/gps/help.txt document, which is downloaded to your local computer after you download the USAPhotoMaps software.

The BAUD rate in USAPhotoMaps has to match the BAUD rate of your GPS receiver.

1. Make sure that the GPS unit is configured to communicate properly with the USAPhotoMaps software program.
   a. Attach the cable to your GPS receiver and to the serial port of your computer (it is probably the only port where the cable will fit properly).
   b. Turn on your Garmin GPS Receiver

2. In USAPhotoMaps software, make sure that the communications port is set to “1”

3. Make sure that the Baud rate is set to 9600.
4. Under <Protocol>, make sure that <Garmin> is selected.

5. Now you are ready to receive your Waypoints! If you get an error message, then let the computer sit idle for a couple of minutes, and try receiving the waypoints again...

6. You should end up with a map that looks something like this (each dot will represent a WayPoint)
7. To identify the actual identification numbers of each Waypoint while scrolling across your aerial photograph, go to the <Text> menu, and select <DISPLAY>.

This will "turn on" the identification numbers of each waypoint when you scroll over them. Use your data logging sheets to determine if these positions are correct or not.

**Tricks and additional hints:**

In addition to adding aerialphotography as a “backdrop”, USA PhotoMaps can also be used to bring up topographic maps in the background of your waypoints and routes!

1. Under the <View> menu, choose <New Type> and <Topo>.

2. If the topographic map does not draw, then go to the <File> menu, select <Download Map Data> and <Full Screen>.

A topographic map should appear in the display window, and your waypoints/routes should draw on top of the topographic map!
EasyGPS – Short Tutorial

EasyGPS is a free, downloadable program from TopoGrafix, and can be found at www.easygps.com. EasyGPS is a quick and easy way to transfer waypoints, routes, and tracks between your computer and GPS unit. EasyGPS lists all of your waypoints on the left side of the screen, and shows a plot of your GPS data on the right. EasyGPS can be used to back up and organize your GPS data.

Setting up EasyGPS
Connecting your GPS unit
From the toolbar, click on Edit>Preferences… In the My GPS Receivers tab, click Add GPS… if your receiver is not listed. Click Settings and select the connection type you are using (USB or COM for a serial port connection).

Click on the Units of Measure tab and check to ensure that the units are set to your preference. Click the My Coordinates Format tab and choose the format you use for your GPS unit (usually, WGS 84).

Transferring Data
To receive data from your GPS unit, connect your unit, turn it on, and click on the Receive icon. A Receive from GPS window will appear. Check the box(es) for the data you would like to receive (Waypoints, Routes, Tracks). Also, ensure that your GPS unit is selected from the dropdown menu. Click OK, and once the data has been sent, a Transfer Complete message should appear on your GPS unit. Sending data from Easy GPS to your GPS unit works in the same manner.

To send select waypoints to your GPS unit, hold down the Control key on your keyboard and click on each of the waypoints you wish to send, then right-click. Select Send Waypoints to GPS, and those waypoints will be sent. To select several waypoints that are adjacent to each other on the list, hold down the Shift key and click the first and last waypoints you’d like to include; those two and all points between will be highlighted.

Waypoints show up in the left side of the screen. The Label (name), Type, and Symbol for each waypoint is displayed. Each of these can be changed by editing the waypoint(s).

Waypoints and Routes
To edit a waypoint, right-click on the waypoint listing and select Edit Waypoint from the menu that appears. Or, while the waypoint of interest is highlighted in the list, in the toolbar, select Edit>Edit and the Edit Waypoint window will appear.

To create a waypoint: In the toolbar on the top of the screen, select Tools>New Waypoint, or, click on the Add icon. An Edit Waypoint window will open, allowing you to enter the appropriate information.
To delete a waypoint, right-click on the waypoint in the waypoint list or on the map (the select arrow cursor must be selected).

To create a route, select the Route tool. Your cursor will become a small diamond, and when you hover over a waypoint, it becomes a larger circle with a + above it. Click on the waypoints in the order you want them in your route. When you are finished, right-click to stop the route.

To delete a route, while the route or select tool is activated, right-click on the route and select Delete Route. Click Yes on the Confirm Delete window that appears.

**Zooming**
- **To zoom in**, select the Zoom icon. Your cursor will become a magnifying glass with a + in the center. Click in the center of the space where you want to zoom. The zoom level shows up at the lower left hand corner of the map side of the screen.
- **To zoom out**, hold down the Alt key while using the zoom cursor.

**Saving Data**
You must save your information in EasyGPS before closing, or it will be lost. Click on the Save icon. If this is the first time you are saving this information, a Save As window will appear. Choose the folder in which you want to save your data, and type in the file name. Be descriptive, such as Smith Property March 12 2007. The file is saved as a GPS Exchange File (.gpx). This file format is not used with most other programs, so if you need to transfer data to another program such as ArcView, you are better off using a program like GPS Utility that can save as other file formats.
GPS Utility
A User Guide for Educators
Prepared by: The Virginia Geospatial Extension Program

Overview

GPS Utility is an easy-to-use software application that allows you to manage, manipulate and map your GPS information. This is a “point and click” software package.

While there are a number of things that GPS Utility software can do, some of the functions most applicable to extension agents include the following:

- Extension agents can use this software package to transfer GPS data between a GPS receiver and a PC.

- GPS Utility can convert GPS data to one of several different text formats (i.e. compatible with spreadsheets, ESRI shapefiles, and other GIS compatible formats, etc.).

- The program converts GPS data (i.e. waypoints, routes, etc.) between different map datums and many coordinate formats (Lat/Long, UTM/UPS, country grids etc.).

- Information can be filtered in various ways and waypoints sorted according to specified criteria. Route and track statistics are available and can be transferred into other programs for analysis (i.e. spreadsheet programs).

GPS Utility also has (some very basic) mapping capabilities. This will at least provide you with some confidence that the data that you have collected with your GPS “looks correct” before you begin downloading your data.

GPS Utility works with a variety of GPS receivers. This guide is written to support the Garmin eTrex series. Most Garmin GPS receivers will follow the same protocols. If you are using a different GPS receiver, then refer to the GPS Utility documentation, or contact the Virginia Geospatial Extension Program.

Before Using GPS Utility

The instructions in this handbook assume the following:

1. You have already installed GPS Utility software on your computer (if not, refer to GPS Utility Installation Instructions. These instructions have been prepared by the Virginia Geospatial Extension Program, with educators in mind. These step-by-step instructions are available online:

   http://www.cnr.vt.edu/gep/tools.html

2. You have already collected GPS Data (i.e. waypoints, routes, tracks, etc.), and have stored the GPS data on your GPS receiver (if not, refer to The Garmin Etrex Legend: An Introductory Handbook for Extension for additional information and instructions. The Garmin handbook has been prepared by the Virginia Geospatial Extension Program. This customized Garmin handbook is also available online:

   http://www.cnr.vt.edu/gep/tools.html

The Virginia Geospatial Extension Program
Let's Get Started Downloading Waypoints

1. Start GPS Utility by selecting it from the Program list on your computer (Figure 1)

2. Make sure that the GPS Utility software is properly configured to work with your Garmin GPS receiver:
   a. Connect your GPS receiver to the computer using the data cable provided with your GPS receiver. Make sure that your GPS receiver is turned on.
   b. Select <GPS> and <Setup> from the GPS Utility software menu interface (Figure 2)
   c. The Interface Setup dialogue box will appear. Make (Figure 3). Select the <Garmin (serial)> option. The baud rate should be set to 9600. Click <OK>.
   d. Select the <GPS> menu again, and select <Connect>.

Your GPS should now be properly communicating with your PC through the GPS Utility software. To verify that your GPS receiver is communicating properly, look at the status bar at the bottom of the GPS Utility dialogue box. It should look something like this →.

3. In GPS Utility, select the <GPS> menu option, and select <download all>.

4. The GPS Transfer dialogue box will appear. You can download “everything” from your GPS at once (and “everything” would include Waypoints, Routes, + Tracks), or you can select the specific items that you need. In this example, I am going to go ahead and download everything.
5. After downloading, you should see a database that show data that is being read from your GPS receiver. In this example, there are 3 waypoints that have been saved on the GPS receiver. The names of these waypoints are AAA, BBB, and CCC.

<table>
<thead>
<tr>
<th>ID</th>
<th>Coordinate</th>
<th>Symbol</th>
<th>TO</th>
<th>Alt(m)</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>AAA</td>
<td>N37.223784 W080.421817</td>
<td>Waypoint</td>
<td>I E</td>
<td>649.5</td>
<td></td>
</tr>
<tr>
<td>BBB</td>
<td>N37.223792 W080.421828</td>
<td>Waypoint</td>
<td>I E</td>
<td>640.8</td>
<td></td>
</tr>
<tr>
<td>CCC</td>
<td>N37.223791 W080.421834</td>
<td>Waypoint</td>
<td>I E</td>
<td>637.5</td>
<td></td>
</tr>
</tbody>
</table>

Note: The <INFO> button on the status bar provides you with summary information about the data that you have collected with your GPS receiver.

6. If you would like to view the other data that GPS Utility is reading from you GPS receiver; then you should select the <VIEW> menu, and select either <Routes> or <Trackpoints>. Refer to page 7 for a description of Trackpoints.
Review of terms:

a. **Waypoints**: These are “virtual points” or marks that you have saved individually. Waypoints can be assigned customized names (the GPS receiver assigns them numerical names [001, 002] by default).

b. **Trackpoints**: Tracks are a previous path of travel. Basically, you turn on your GPS receiver, and it will start to “map your movements” (similar to dropping virtual bread crumbs). **Trackpoints** are individual points that are used to create a track (if you connect these points, with a line, you would have a track).

c. **Routes**: A route is a “path to a destination with intermediate stops along the way”. The “stops” along the way are defined by Waypoints. You can define your route in the field, or wait to define a route from existing waypoints when you return to your office.

d. **Tracksummary**: a log that summarizes your tracks (time and date stamps, etc.)

**Viewing GPS Data**

GPS Utility provides some basic viewing capabilities that enable you to “see” if the data that you have collected “looks correct”. I typically use this to verify that waypoints, tracks, etc. “look” correct before downloading the data onto my PC. However, the best (more failsafe) way to verify that your data “looks” correct is to use a (free) software program called USAPhotoMaps (http://www.jdmcox.com). You can not add additional layers of information as a “background” to GPS Utility. However, you can change the colors and symbols associated with waypoints, tracks, etc.

To visually examine your data, click on the <Map button> 

A graphic image of all of your waypoints and tracks should appear. Waypoints are identified (by default) with red crosshairs. Furthermore, their ID number/name should be located near the red cross hairs

In addition, there are some basic map interface tools that you can use to pan around, zoom in, zoom out, etc.

These mapping tools are a bit “clunky” but they get the job done.
Converting data between different coordinate systems

Another nice capability associated with GPS Utility, is the ability to easily convert GPS data from one coordinate system to another (i.e. convert from Lat./Long. DMS to Lat./Long. DD, UTM, etc.)

To convert GPS data from one coordinate system to another, simply select your desired coordinate system pull down menu!

Setting up Your database fields

GPS Utility allows you to set the fields that you would like to appear in the Attributes Table of your data once you have saved it. To do this, go to <Options> and the <Data Base Fields>. The “Options Settings” Dialog Box will appear and you will be on the Data Base Fields tab. A table listing possible fields is visible.

If the “Width” field has a numerical value other than “0”, the field will appear in your Attributes table. If “0” is in a field that you would like in your table, you must specify a column width other than “0” so the field will appear. Once you decide what fields you would like, you are ready to save your data!
Saving Your data to a PC
You can save the data that you have collected on your GPS receiver directly as a file in your PC as a "GIS readable" file (i.e. shapefile).

1. Make sure the file that you want to save (i.e. Waypoints, Tracks, etc.) is visible.
2. Under the <File> menu, select <SAVE AS>
3. To save in a GIS compatible format,
   a. enter a <Filename>
   b. under the <Save As Type>, option, choose either:
      - Dbase Waypoint Fileset - this option saves waypoints, and saves Tracks as a series of points
      - Shape Trackpoint Fileset - this option saves Tracks as a linear feature. Refer to the figure below for a graphic depiction of these two options...

And Presto! You have created a GIS compatible file from your GPS data!

Waypoints are points, that, when connected, will form a linear track (or a "trackpoint").
Uploading data to your GPS

There are two simple steps to upload data (Waypoints, Tracks and Routes) from GPS Utility into your GPS unit.

**Step 1. Loading Data**

The first step is to load your data file into the GPS Utility data table. You will need to retrieve your previously saved data. To do this, go to select the <File> menu, then select <Open>. From the box titled "Open" you can select your data file. Be sure to select correct file type using the "File type" pull down menu. When the data has been loaded in to the Data Table you may edit it before uploading into your GPS unit.

**Step 2. Upload data to the GPS**

In order to upload data your GPS unit must be connected to your computer and turned on. GPS Utility lets the user select what type of data to upload (Waypoints/Tracks/Routes). To Upload data to your GPS unit select the <GPS> pull down menu or select the upload button on your tool bar.

You have the choice of selecting individual points to upload by clicking <Upload Highlighted> (note: data must be highlighted before selecting this option) or the other option is to upload all data by selecting <Upload All>.

Regardless of which method of uploading you select, a box should appear to confirm the upload of data. This is also your opportunity to select which type of data to upload (Waypoints/Tracks/Routes). Check only the type of data you wish to upload to your GPS unit and click OK.

The information bar at the bottom of the screen should verify the completion of the upload.
How to Calculate Area and Perimeter

Area and Perimeter Calculations may only be determined from a Track or a Route.

Creating a Route From Waypoints
Download waypoints from your GPS or open an existing file (for more information see previous sections). Open the <View> menu and select <Routes> or select the Route button from your tool bar.

To create a route from your existing waypoints open the <Record> menu and select <New>.

This will bring up a list of waypoints. Waypoints may be added to your route by a single click on each desired point. GPS Utility will close your route automatically so there is no need to start and end at the same point. You should be able to see the points you have added appear on the route data table. When you are finished close the waypoints box.

Calculating Area and Perimeter
To view the calculated area and perimeter of your route open the <View> menu and select <Reports>. This will bring up a report of your route, the start to end distance (meters) and area in hectares can be found at the bottom of the report.
For further information, contact the Virginia Geospatial Extension Program:

John McGee
Virginia Geospatial Extension Specialist
(540) 231-2428
jmcg@vt.edu
http://www.cnr.vt.edu/gep

Welcome Aboard!

Virginia’s Geospatial Extension Program, in partnership with the Virginia Space Grant Consortium and Virginia Cooperative Extension, seeks to promote the integration of geospatial tools and techniques through a coordinated approach at the local, regional, and state levels. The program aims to extend opportunities and empower organizations and individuals across the Commonwealth of Virginia through training, assessing application needs, and providing increased access to data resources.

Initiatives associated with this program include:
- technology and application training,
- information sharing,
- course development and dissemination, and
- educational outreach.

This program meets crucial workforce needs by providing K-12 educational outreach, specialized workforce courses, and training through Virginia’s Community College System (VCOS) and other Virginia Space Grant Consortium (VSGC) member universities, faculty development, and linkages to NASA and other geospatial resources for data and programs. A key component of this program is its participation with Virginia extension agents, through Agriculture and Natural Resource programs and 4-H Youth Educational initiatives, to support the dissemination of information, training, and application development at the grassroots level.
Using GPS with Google Earth

Google Earth is a powerful free tool for visualizing geographic data and for browsing web content in a spatial interface. Although it does not allow for the measurement of area or include topographic map images, using several free programs in concert can give you many of the features that you would otherwise have to pay for.

What is Google Earth?
Earth is a software program that displays satellite imagery from an online server overlaid on topographic data, creating a digital three-dimensional model of the planet Earth. Earth has many features, including a flight simulator, three-dimensional structures, and the ability to view user-created content, but this tutorial will focus on the features most relevant to forest stewardship.

A GPS data import tool was added to Google Earth 5.0, released in early 2009. The interface supports only Magellan and Garmin brand GPS units. Google Earth is available for free download from google.earth.com. Google Earth Pro has several additional features like quicker access to the image server, higher resolution print quality, and the ability to measure area, and costs $400.

Getting Started
After downloading and installing the software, plug in your GPS unit and open Earth. Under the Tools menu, click “GPS.” In the “GPS Import” box, select the appropriate brand name. If you have a Magellan, select “serial” if you have a 9-pin connector cable, rather than a USB cable. Otherwise, select “Explorist.” If you do have a serial cable, make sure that the baud rate in the setup menu of the GPS unit is set to 4800. If you have a Garmin, make sure that you have installed the USB driver that came with your GPS unit.

Select the data types you want to download. Under Options, choose your drawing preferences. Check “Draw icons at track and route points” if you want an icon to be displayed for every track/route point recorded by your GPS unit. This may clutter your display. Check “Draw lines for tracks and routes” to draw each GPS track and route as a solid line. Check the “Adjust altitude to ground height” check box to adjust all recorded points to ground level. This will ignore the altitude data stored
with the points and make sure that your data appears on the surface. Now click "Import."

Your data will appear under “Temporary Places” in the Places sidebar on the left. Right click on the name and select “Save to My Places” so that it will still show up the next time you open Earth. Click the plus signs next to the folders until you see a list of points. Double-click one of them to fly to its location in the viewer.

If your GPS unit is not supported
The Earth GPS interface only supports Magellan and Garmin brand GPS units, and may not work with older models. If your unit is of a different brand or is an older unsupported model, you can still import your GPS data using free software like EasyGPS, GPS Utility, or GPS TrackMaker, and then saving your data as a [gpx, kml, or kmz] file.

Follow the instructions in this manual for importing data in one of these other programs, then under the File menu, select “Save As…” In the drop-down “Save as type” menu, select “GPS Exchange File (gpx)” or “Google Earth (kml).” Name the file something descriptive (e.g. “west woodlot”) and remember where you save it.

Then in Google Earth, click “Open…” under the File menu. Find the file you just saved and click “Open.” Your file will appear in the “Places” sidebar on the left under “Temporary Places.” Right click the name and select “Save to My Places” so that it will still show up the next time you open Earth.

Navigating Earth
There are several controls for navigating through the viewer. You can start by double-clicking on one of the places listed in the sidebar, or by searching for somewhere new.

The easiest way to move around an area is the pan tool. Simply grab the image by left-clicking and then drag in the direction you want to move the image. Letting go of the mouse button while continuing to move the mouse will ‘throw’ the image, making the pan continue until you click the image again.

Zoom in or out by using either your mouse wheel, by double-clicking on the image, by right-clicking and dragging, or by sliding the zoom scale on the right side of the screen. The default view is from directly above, but if you want to see the topography of a location, you need to tilt the view. You can do this by holding down the mouse wheel and dragging, or by using the compass icon in the top right corner of the screen.

Viewing historical imagery
You can view historical imagery to see how a property has changed over time. Click the clock icon in the toolbar to show the time slider. Each tick on the slider bar represents a different image. The number, quality, and age of the available images varies greatly from place to place.
Measuring distances
You can measure distances in Earth by clicking the ruler tool in the toolbar. The line tab only allows one segment at a time, but allows tells you the heading of the line, while the path tab gives you the total distance of many segments. Google Earth Pro also has tools for measuring the area of polygons and circles.

Creating shapes
You can create points, polygons, and lines to mark the corners and boundaries of property, stands, and management units and to keep notes on each. Click one of the shape tools in the toolbar.

While the properties window is displayed, draw the point, line, or polygon where you want it to appear on the map. You can move the properties window partly off the screen if it is in the way. Click and drag to create a curvy line, or click once on each corner for simple straight lines. You can add text and change the colors and other properties under the tabs at the top of the properties box. When you're done editing, click the OK button. To edit the shape or properties again later, right click on the shape’s name in the Places panel and select “Properties.”

Exporting data
Earth does not have a GPS data export function. In order to upload data that you have created or modified in Earth onto your GPS unit, you must first save it and then upload it using another data management software program like EasyGPS, GPS TrackMaker, or GPS Utility.

To save data, right click on the name in the Places panel of the sidebar and select “Save Place As…” Choose a file name and file type. The [kml] file type is accepted by more software programs, while the [kmz] file type is compressed and can also store pictures. Open the data management software of your choice, select “Open…” under the file menu, and choose the file you just saved. Now you can upload it to your GPS unit as you normally would.

More information
Terrain Navigator
A User Guide for Natural Resource Managers
Prepared by: The Virginia Geospatial Extension Program

Overview
Terrain Navigator was developed by MapTech. Terrain Navigator (standard edition) is an easy-to-use mapping software that allows you to manage and manipulate your topographic maps and GPS information.

While there are a number of features included in Terrain Navigator software, some of the functions most applicable to average users include the following:

- Terrain Navigator can be used to find locations quickly and view and print topographic maps in 2D and 3D.
- Map datum and coordinates can be specified in a number of formats including UTM and Lat/Long.
- This software package can transfer GPS data (i.e. waypoints, routes, tracks, etc.) between a GPS receiver and a PC.
- Points, labels and routes can be added to topographic maps.
- Terrain Navigator can be used for basic measurements such as distances, areas and elevation profiles.

Terrain Navigator has some very good mapping capabilities. This provides you with confidence that the data that you have collected with your GPS "looks correct" on topographic maps. Also it can help in determining imprecise GPS points that were collected. Terrain Navigator works with a variety of GPS receivers. This guide is written to support the Garmin Legend GPS receiver. Most Garmin GPS receivers will follow the same protocols. If you are using a different GPS receiver, then refer to the Terrain Navigator documentation, or contact the Virginia Geospatial Extension Program.

Before Using Terrain Navigator
The instructions in this handbook assume the following:

1. You have already installed Terrain Navigator software on your computer.

2. You have already collected GPS Data (i.e. waypoints, routes, tracks, etc.), and have stored the GPS data on your GPS receiver (if not, refer to The Garmin Etrex Legend: An Introductory Handbook for Extension Agents for additional information and instructions. The Garmin handbook has been prepared by the Virginia Geospatial Extension Program. This customized Garmin handbook is also available on-line:

   [http://www.cnri.vt.edu/gep/tools.html](http://www.cnri.vt.edu/gep/tools.html)

Table of Contents

| Opening Maps & Searching | 2 |
| Tools for Viewing Maps | 3-4 |
| Printing Maps | 5 |
| 3-D Features | 5-6 |
| Working with your GPS | 6-8 |
| Layers (Markers, Tracks, etc.) | 8-9 |
| Measuring Tools | 9-10 |
| Changing Datum | 10 |

The Virginia Geospatial Extension Program
Let's Get Started - Opening Maps

1. Start Terrain Navigator by selecting it from the Program list on your computer (Figure 1).

   ![Program List](image)

2. When you open Terrain Navigator, the Map Selector appears. You can also open the Map Selector by clicking File > Open or by selecting the Map Selector button on the tool bar.

   The Map Selector will display an overview of the state of Virginia, the grid shows the area covered by each map. Terrain Navigator opens maps from the CDs provided with the package, and does not store maps on your computer. For this reason you must insert one of the four "USGS Topographic Series" CDs for Virginia.

3. Select a map scale
   Under the "Map Type" pull down menu you are given two choices of scale:

   - 1:24,000/25,000 - The most commonly used because they provide good detail for hiking, hunting, etc.
   - 1:100,000 - These maps don't provide much detail, but they cover large areas and provide a good landscape view.

   You can always change your map scale anytime during a project by using the map scale button on the tool bar.

4. Opening Maps
   Using the "Map Name" drop down menu you can select maps by name. When you select a name of a map then a square on the grid will become highlighted indicating the location of the map. When you are sure of your map name press "Open." Another way to open a map is to double click on the map grid.

Searching

Maptech software has a "Find" feature which is an excellent tool to search for and quickly locate a particular area. When you have a map open, click on the "Find" menu and select "City/Town."
Using the Find City/Town feature is simple; just type in the name of the town you wish to find and select from the available options in the list below. If the city name is common you may select to limit your search to the CD currently in the drive if you know you will be searching in that region. To open a map of this area you can click the bottom "Replace Active" or just double click on the name of the city/town you wish to view. This will close whatever map you had been viewing and open the new map. You open the map in a new window by clicking the button “Open Another.” The opened map will have a red circle around the town or city selected.

The Find menu is an excellent tool and can be used to find locations in many other ways. Another great option is the “Zip Code” option on the “Find” pull down menu. This feature works very much like the find City/Town option except you can search using zip codes. The find feature also is great for finding bookmarks, waypoints, tracks, routes and labels that will be discussed in future sections.

**Viewing Maps in 2D**

This section will introduce the major tools needed to navigate topographical maps in 2D.

The **drag tool** is the best tool for moving around the topo maps. To use this tool, just click (hold) and drag the map on the screen. Another good feature of the drag tool is it changes to a scrolling arrow when you hold the tool at the edge of the map (this feature works on almost all cursor tools). After the drag tool changes to a scrolling arrow just click and the map will scroll in the direction of the arrow.

**Map Overview**

The Map Overview feature is located on the side tool bar; it is a thumbnail image of the map that you're viewing. The blue box represents the area of the map you are currently viewing. This feature is much like the drag tool; you can click (hold) on the box and move it to a new location or you can click on an area of the map to re-center the map. By clicking on the black arrow pointing to the map overview it will open up a window with a large version of the map overview.

The Virginia Geospatial Extension Program
State Overview
This feature gives the general location of the map you are viewing with the location of the red dot. If you click on the black arrow pointing to the State overview, this will open up the "Open Map" window discussed in previous sections.

Centering Tool
This tool can be found on the tool bar. To use this tool just left click on the map, and the map will be re-center around the point you have just selected. Also with this tool and most others as you use the mouse to move your tool, the coordinates and elevation will be displayed on the tool bar.

Compass Control
This tool provides yet another way to move the viewing screen. To use this tool just click on the compass direction you wish the map to scroll. For example, if you want to view a map section to the north click on the north arrow on the compass.

Zoom In/Out
When Terrain Navigator is first open the scale will 1:1 or the actual scale of the map. This program offers four different zoom levels 1:4, 1:2, 1:1 and 2:1, where 1:4 (25% of actual scale) is the maximum outward view and 2:1 (200% of actual scale) is the maximum inward zoom level. Just use the "Zoom Level" on the toolbar to select the zoom level desired.

Don't forget that there are also two different map scales 1:24,000 (detailed view) and 1:100,000. The four zoom levels are available on each of the different scale maps. If you find that you cannot zoom it to the desired level, change the map scale from 1:100,000 to 1:24,000 might solve the problem.

Terrain Navigator provides four zoom levels for viewing maps. To zoom select the Zoom In or Zoom Out tool, then click on the map. The map will center automatically on the point you clicked. Another option is to right click on the map and select Zoom In or Zoom Out from the menu that appears.

Bookmarks
Bookmarks are used to save specific locations so you can return to them later at the same zoom level and map scale. To save a bookmark select "Bookmark this View" on the "View" pull down menu and enter a name for your bookmark. To find your bookmark use the find feature, "Find" menu then select "Bookmark" (mentioned in more detail in a previous section).
Printing Maps

To the map you are viewing select the "File" menu and select "Print." This will display a map that you are about to print. A blue box (similar to the map overview) will display the area to be printed. This box can be moved (dragged) or centered before you print. If there is no blue box present the whole map as seen will be printed. There are many options provided on the right side of the print window.

The size can be changed, this will essentially change the zoom level of the printed map and the size of the printing area. The size can be adjusted using the scale or percent, "%" is the default. Adjusting the "%" will adjust the percent of the actual scale. Simply a large percent like 200% will zoom in to great detail and a small percent like 10% will display a larger area but in less detail. As the scale is adjusted the size of the blue box will change indicating the area that will be printed. The scale limits are 25% to 1000%.

Quality - The quality of the print can be using the "Quality" pull down menu. All options are expressed in dpi (dots per square inch), the higher the dpi the higher quality of the printing. Quality can also be set by clicking the "Setup" button.

Weight – This refers to the amount or density of ink used in printing.

Summary – when this option is checked, a box will be included at the base of the map including the USGS map name, date, scale (1 inch = x feet), coordinates, and caption.

Layers - Layers are markers, routes, tracks and can be included on your printout when this box is checked. The pull down menu to the side is to choose the size (Small, Medium or Large) at which the layers will be displayed. The Layer Information check box will provide sheet printed in addition to your map that includes data about the layers.

Other map options include Gridlines, Scale Bar, North Arrow all good features for reading and interpreting maps. To Add these features just click on the checkbox next to the label.

3-D View

Terrain Navigator features a 3-D View which provides an additional way to view the shape of the landscape. To use this feature click on the 3-D button on the main tool bar which will display a 3-D view of the terrain.
Zooming In / Out (3-D) - The controls differ from the 2-D view. To zoom in or out, click on the arrows on the side toolbar. The direction listed just above these arrows (in this case “N”) identifies the direction you are looking at the map.

Raising / Lowering the Viewpoint - This feature changes the height at which you are viewing the 3-D map. To adjust the viewpoint, click and hold on the lever then drag it up or down. The elevation tool can be found on the side toolbar. The higher you drag the level the farther you will be from the map.

Rotation - The rotation tool lets changes the viewing angle of the map. The right and left arrows will spin the view around your centered point, thus giving the illusion that your rotating around that point. The up and down arrows change the view angle from by raising and lowering the view point, basically the same thing as the Viewpoint feature just above it.

Using the Cursor - The cursor can be used to change the view as well. Just click and hold on the map and drag to change the view. Using the cursor you can rotate and tilt the 3-D map.

Height Exaggeration Buttons - These buttons simply exaggerate the height of the terrain in 3-D display. The up arrow increases the height of mountains and hills and the down arrow shrinks them. These tools are found at the bottom of the side tool bar.

Recording a 3-D Rotation Video Clip - This feature allows you to make a recording of the 3-D rotation around a center point. To use this feature just select the video tool at the bottom of the side tool bar or select “File” menu -> “Export” -> “Rotation Video Clip.” This feature can also be used to make videos of routes in which case select “Route Video Clip.” Save this clip and click ok. Note the Route Video clip has additional optional settings that can be changed. The clip will only take a few seconds to be produced and can be opened using windows media player.

3-D Glasses View - You can view your 3-D map using the glasses provided with Terrain Navigator. Just click this button and it will take you to the 3-D glasses view. To exit the 3-D glasses view just left click on the mouse again. Note rotation of the map is not possible in 3-D glasses view.

Integrating Terrain Navigator with your Global Positioning System
Terrain Navigator can be used as a software application to download waypoints, tracks and routes from your GPS receiver to the PC. These features can then be integrated with (ontop of) Terrain Navigator’s mapping capabilities.

Configure Your GPS
Terrain Navigator software offers a way to setup your GPS automatically, using GPS Setup Wizard. This feature is offered during the initial software setup. However if you skipped this step or want to add a new
GPS you can run the feature by clicking on the “GPS” pull down menu then selecting “GPS Setup Wizard.”

The GPS Setup Wizard does require that you answer the questions on each screen. When the Wizard is complete, Terrain Navigator will recognize and communicate with your GPS unit.

Note if you are unable to configure your GPS using the GPS Setup Wizard your GPS can be configured manually by selecting “Setup” from the “GPS” pull down menu. For more assistance with this feature consult Terrain Navigator’s help section.

Receiving data from your GPS
Using Terrain Navigator waypoints, tracks and routes can be downloaded from your GPS to topographical maps. Before you begin make sure the GPS receiver is connected to the computer and turned on. To receive data from your GPS click on the “GPS” pull down menu then select “Receive from GPS” and choose a type of data by clicking “Receive Waypoints/Track Logs/Routes.”

Terrain Navigator will create a list of all data points that are on your GPS, these points will be displayed in a new window called “Received Waypoints/Track Logs/Routes.” To load points into Terrain Navigator the data must be selected from the list. Note to select more than one data point hold down the control key when using the mouse. When you selected the data you wish to download press the OK button. A message box will appear identifying the number of data points received.

After the data points are received from the GPS they will be displayed on the map. In this program GPS data is know as “Layers” and waypoints are also referred to as “Markers.” Layers can be view by clicking on the “Layers” pull down menu and selecting the type of data you are interested in (markers, tracks, routes). Layers can be turned off and on by clicking on the “View” pull down menu and selecting “Layer Visibility.”

Sending data to your GPS
A very valuable feature of Terrain Navigator is that you can transfer data or layers from your computer to your GPS. This program lets you send all Layers (Markers, Tracks, and Routes) directly to your GPS so you can find these features in the field. Before you start this process make sure you have your GPS unit turned on and connected to your computer. Sending is much like receiving data, just click on the “GPS” pull down menu, select “Send to GPS” then choose what type of layer you wish to send you GPS by clicking “Send Markers/Tracks/Routes.” A box will appear with all the possible points that can be sent to the GPS. Select the points you wish send, use the control key to select more than one point. When you have finished your selection click the send button. The data should appear in your GPS as waypoints, tracks, or routes.
GPS Real-Time Tracking

This feature is designed for use in a moving vehicle, as it monitors your movement on the map. Using this feature you can record your movements and save it as a track. To use this feature your GPS unit should be plugged in and turned on. Click on the GPS pull down menu and select “GPS Tracking” then select “Start Tracking” or to record your actions while tracking select “Record Tracking.” When your GPS unit receives enough satellites Terrain Navigator will open a map marking your location on with a tracking. Changing tracking Preferences

Using this feature you can change how Terrain Navigator tracks your position. To use this feature click on the “GPS” pull down menu and select “Options” then “Display Options.” Here you can change the icon displayed size and other visual features. The time interval between tracking points may be changed, which may be important depending on your speed. Also screen features can be changed.

Creating Layers (Markers/Tracks/Routes)

Creating layers is simple and can be invaluable for finding your way in new terrain because you can load these features to your GPS.

Markers

To create new markers you can use the marker tool on the top tool bar or click on the “Tools” pull down menu and select “Markers.” Markers can be used to indicate a place of interest and can be loaded on to your GPS as Waypoints. Because it is much easier to name and label points in Terrain Navigator than on your GPS this is a valuable tool. When the marker tool is selected, markers should be created on the map where you left click.

To change the text of the marker, just left click on the text, this will give you the option to change the marker name. If you wish to change more features or add comments right click on the marker and select edit. Using the right click menu you can also get information, hide the marker, and delete the marker and perform other tasks.
To move Markers you must be using the “Marker tool.” Hold the Cursor over the marker tool until the cursor icon changes to a maker/hand tool. At this point you can hold click and drag the marker to a new location.

Tracks and Routes
To add these features you must be using the Track or Route tools with can be found on the top tool bar or on the “Tools” pull down menu. Routes connect a series of waypoints where as tracks are just lines without points in between. Both can be loaded on to your GPS unit. To create these features just click on the map using the Track or Route tool to begin your line. Additional points or clicks should be added to change the direction of the line. When the Track or Route is finished, right click and select “Finish Track/Route” from the cursor menu. Editing and adding text and information can be done in the same way markers are edited. Tracks/Routes can be added to after completed by right clicking (using the track or route tool) and selecting append route/track. They can also be closed or looped by selecting “Toggle Route Loop” from the right click menu.

Measuring Tools
Distance can be calculated by using one of two measuring tools. Use the Distance tool for straight-line measurements, Terrain Navigator will provide the length and bearing, and elevation. The other distance tool provides information for curved lines and measurements. Select one of the distance tools and choose at least points on the map to calculate distance. To delete the last segment drew use the backspace key on your keyboard. Hold down the control key if you need to drag the map. To create curved lines click and hold the cursor. To get information such as distance about the segment right click on the line and select “Information” from the menu. The right click menu also provides other tools such as option to covert to a track or route. To erase all of the line segments right click on the line and select “Clear” or use the Delete Tool.

Profile
Another option from the right click cursor menu (using Distance, Tracks or Routes) is the “Profile” feature, which can also be found on the top tool bar. This shows the elevation and terrain crossed by the route or distance line. This feature can also be found in the same way for tracks and routes. This feature is very similar to the “Line of Sight Tool” which displays the profile with a line of visibility.
Measuring Area
This feature can be used only if the line is looped or forms an enclosure. To obtain the area information just right click on the line and select “information.” Area information is also collected for toggled routes under the information feature.

Changing Datum
Basically datum is a way of calculating the location of the earth’s center. The earth’s center is used as a point for establishing coordinate locations on the earth’s surface. There are three forms of datum used by Terrain Navigator. This becomes important when transferring points from your GPS because, the datum must match. To change the datum click on the “File” pull down menu select “Preferences” then select “General.”
For additional updates and information about this digital resource, contact the Virginia Geospatial Extension Program:

The Virginia Geospatial Extension Program
Virginia Tech
319 Cheatham Hall
Mailcode 0324
Blacksburg, VA 24061

John McGee
Virginia Geospatial Extension Specialist
(540) 231-2428
jmcg@vt.edu
http://www.cnr.vt.edu/gep

Acknowledgements: Luke Petre

The Virginia Geospatial Extension Program
Common GPS Terms

Accuracy – A measure of how close an estimate of a GPS position is to the true location.

Azimuth – The compass direction from a position to a destination expressed as an angular measure from north and measured clockwise. Most commonly expressed as $0^\circ$ – $360^\circ$ degrees measured clockwise. GPS units use azimuth to express direction.

Bearing – The compass direction expressed as a measurement from a given quadrant, such as North $36^\circ$ East. The angular measure ($36$ in this case) will reference the acute (less than $90$) angle from the North or South meridian as measured to the East or West. Bearings will need to converted to azimuth for use in the GPS unit.

Coordinate Systems – Such as latitude/longitude, represent your position on the earth to a flat surface like a sale map.

Course – The compass direction you are trying to follow from your starting point to the point you are trying to reach.

Course Over Ground – see Track

Declination Setting - GPS units can be adjusted to the amount of magnetic declination in the area of use.

Differential GPS (DGPS) - An extension of the GPS system that uses land-based radio beacons to transmit position corrections to GPS receivers. DGPS reduces the effect of selective availability, propagation delay, etc. and can improve position accuracy to better than 10 meters.

Direction – The direction between two locations is usually called a bearing, azimuth, or course.

Error – Measurement of horizontal position error in feet or meters based on a variety of factors including Dilution of Precision (DOP) and satellite signal quality.

GOTO – The selected point you wish to travel to or find. It may be a position fix or part of a route or track.

Heading - The direction in which you or your vehicle are moving. For boat or airplane operations, this may differ from actual Course Over Ground (COG) due to winds, currents, etc.

Latitude - A position's distance north or south of the equator, measured by degrees from zero to 90. One minute of latitude equals one nautical mile.

Location – The actual physical place you occupy. The difference between a position fix and location is that a location is where you really are and a position fix is where a GPS unit says you are.
Longitude - The distance east or west of the prime meridian (measured in degrees). The prime meridian runs from the North Pole to the South Pole, through Greenwich, England.

Magnetic Declination – The difference between true north and magnetic north at a specific location.

Navigation - The act of determining the course or heading of movement. This movement could be for a plane, ship, automobile, person on foot, or any other similar means.

NAVSTAR - The official U.S. Government name given to the GPS satellite system. NAVSTAR is an acronym for Navigation Satellite Timing and Ranging.

Position fix - The GPS receiver's computed position coordinates.

Precision – Measure of the “repeatability” of the data. Taking repeated readings from a point will improve the precision of the sample mean.

Route - A group of waypoints entered into the GPS receiver in the sequence you desire to navigate them.

Track - Your current direction of travel relative to a ground position (same as Course Over Ground).

Trilateration – Mathematical technique used by GPS navigators to determine user position, speed and elevation. The GPS unit constantly receives and analyzes radio signals from GPS satellites, calculating precise distance to each satellite. Four satellites are generally needed to determine an accurate elevation and distance.

Waypoint/Landmark - Waypoints are locations or landmarks worth recording and storing in your GPS. These are locations you may later want to return to or avoid. They may be check points on a route or significant ground features such as a campsite, the truck, a cultural resource, or a favorite fishing spot. Waypoints may be defined and stored in the unit manually by taking coordinates for the waypoint from a map or other reference. This can be done before ever leaving home. Or more usually, waypoints may be entered directly by taking a reading with the unit at the location itself, giving it a name, and then saving the point.

Wide Area Augmentation System (WAAS) - A system of satellites and ground stations operated by the Federal Aviation Authority that provide GPS signal corrections for better position accuracy for airplanes. WAAS consists of approximately 25 ground reference stations positioned across the United States that monitor GPS satellite data. Two master stations, located on either coast, collect data from the reference stations and create a GPS correction message. A WAAS-capable receiver can be adapted to ground use and give you a position accuracy of better than three meters, 95 percent of the time. It is only accessed if you are in the open, not in forest cover.

Definitions courtesy of Garmin International, Inc.
# GPS Hardware and Software Resource List

## Hardware: GPS Receivers (2006 prices)

### Garmin: [www.garmin.com](http://www.garmin.com)

<table>
<thead>
<tr>
<th></th>
<th>High-end</th>
<th>Mid-priced</th>
<th>Low-end</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unit</strong></td>
<td>GPSMap 76Cx</td>
<td>GPSMAP 76</td>
<td>eTrex Legend</td>
</tr>
<tr>
<td><strong>Cost</strong></td>
<td>$535.70</td>
<td>$199.99</td>
<td>$160.70</td>
</tr>
</tbody>
</table>

### Magellan: [www.magellangps.com](http://www.magellangps.com)

<table>
<thead>
<tr>
<th></th>
<th>High-end</th>
<th>Mid-priced</th>
<th>Low-end</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unit</strong></td>
<td>eXplorist XL</td>
<td>eXplorist 500</td>
<td>eXplorist 200</td>
</tr>
<tr>
<td><strong>Cost</strong></td>
<td>$399.99</td>
<td>$199.99</td>
<td>$149.99</td>
</tr>
</tbody>
</table>

### Lowrance: [www.lowrance.com](http://www.lowrance.com)

<table>
<thead>
<tr>
<th></th>
<th>High-end</th>
<th>Mid-priced</th>
<th>Low-end</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unit</strong></td>
<td>iFinder Hunt Color Plus</td>
<td>iFinder H2O Plus</td>
<td>iFinder H2O</td>
</tr>
<tr>
<td><strong>Cost</strong></td>
<td>$449.95</td>
<td>$249.95</td>
<td>$165.95</td>
</tr>
</tbody>
</table>

Prices listed are recommended list price from manufacturer website. Most units can be found for a lower price at various stores and online, such as [www.amazon.com](http://www.amazon.com), [www.tigergps.com](http://www.tigergps.com), and [www.thegpsstore.com](http://www.thegpsstore.com).

## Software

### Terrain Navigator by Maptech: [www.maptech.com](http://www.maptech.com)

- **Cost:** $99.95 per state.
- **Features:** USGS topographic maps; 2-D and 3-D maps; upload and download routes, tracks, and waypoints; shows profiles of elevation over a route; personalize, then print maps showing your routes and waypoints. By purchasing Terrain Navigator Pro, you can access aerial photographs.

### Mapsource TOPO USA 2008 DVD by Garmin: [http://gpsnow.com/gmms.htm](http://gpsnow.com/gmms.htm)

- **Cost:** $80 - $120, depending on program
- **Features:** view color maps; create waypoints, routes, and tracks, and transfer them between your GPS unit and computer. Send detailed maps from the computer to your GPS unit for maps that show minor roads and points of interest.

### Expert GPS: [www.expertgps.com](http://www.expertgps.com)

- **Cost:** $59.95
- **Features:** exchange data with Excel, Topo, Terrain Navigator and others; connects your GPS to internet mapping and information sites giving access to street maps, weather forecasts, and attractions.
**Topo USA 6.0 National by DeLorme: delorme.com**
Cost: $99.95
Features: 2-D and 3-D maps, profiles show elevation gains between points, draw on maps, measure linear distances, embed photos and URLs to maps, link digital photos to a GPS log to show where the picture was taken.

**USAPhotoMaps by JDMCox Software: www.jdmcox.com**
Cost: free
Features: downloads USGS aerial photo and topographical map data from Microsoft's free TerraServer Web site, saves it on your hard drive, and creates maps with GPS accuracy. You can go to any address, landmark, etc. and view its photo or topographical map. Add waypoints, routes, and text; transfer to and from your GPS unit.

**Easy GPS:** [www.easygps.com](http://www.easygps.com)
Cost: free
Features: upload and download routes and waypoints, create routes. This program is very basic, but very easy to use. You can change waypoint symbols, view and print simple maps of your routes and waypoints, and enter new coordinates. It does not show maps or terrain features.

**GPS Utility:** [www.gpsu.co.uk](http://www.gpsu.co.uk)
Cost: free
Features: transfer data to/from a GPS receiver and store the data in PC files in one of several text formats. The program converts between different map datums and many coordinate formats. Route and track statistics are available and can be transferred into other programs for analysis (i.e. spreadsheet programs).

**Google Earth:** [http://earth.google.com](http://earth.google.com)
Cost: free
Features: lets you fly anywhere on Earth to view current color satellite imagery, maps, terrain, and 3D buildings. You type in an address and the program will take you to that location. You can download GPS points onto google earth maps from a GPS unit. You can also create waypoints on google earth maps that can be saved as a [****.kml] file and then transferred to GPSUtility and then uploaded to the GPS unit.
Web-Based Resources

Information about GPS

http://gps/faa.gov/gpsbasics/index.htm
Information from the FAA about GPS basics, how WAAS works, and much more.

http://pnt.gov/101
Information about GPS, national and international augmentation systems, and links to other government-based GPS resources from the National Space-Based Positioning, Navigation, and Timing (PNT) Executive Committee.

Mapping/GIS Resources

www.mdmerlin.net
Create free custom maps of locations in Maryland showing property lines, wetlands, roads, aerial photos, and more.

http://seamless.usgs.gov
U.S. Geological Survey (USGS) and the EROS Data Center (EDC) provide geospatial data through The National Map. View and download many geospatial data layers, such as National Elevation Dataset, National Land Cover Dataset, high resolution orthoimagery, and hydrography.

http://sdatcert3.resiusa.org/rp_rewrite
The Maryland Department of Assessments and Taxation Real Property Data Search offers information on property sales and ownership.

http://websoilsurvey.nrcs.usda.gov/app
Web soil surveys provide soil data via overlays on aerial photos.

Additional Resources

www.naturalresources.umd.edu/GPS.cfm
The beginner and advanced GPS training materials from Maryland Cooperative Extension are available online, along with links to software programs and materials from other sources.
Merlin Online

Merlin Online was developed by Maryland Department of Natural Resources. It is available for free use at [www.mdmerlin.net](http://www.mdmerlin.net). Merlin Online is an electronic atlas that allows a user to produce a custom "map" for any location in Maryland. The map can include any of the available layer data, such as property information, wetland delineation, soils, roads, USGS topo maps, and aerial photographs.

An internet connection is required. If you have a dial-up connection, it may take a long time to load parts of the program. Before trying to use Merlin Online, be sure your computer has a recent version of Internet Explorer or Netscape, and enable Java or Microsoft Virtual Machine.

**Making a map**

Go to [www.mdmerlin.net](http://www.mdmerlin.net) and click Make A Map. You will be sent to a Notices page; scroll to the bottom and click OK. A new window will appear with the Map Selection Menu. (This window may take a moment to load.) Click County. Select a county from the list.

The county map will open. To zoom in to view a particular area, click on the Zoom Box icon. A red box will appear. Move the box to where you want to view, and click Zoom. You can re-size the zoom box by placing your cursor over the outline, then clicking and dragging.

The Layer Control box on the left side of the screen allows you to check the boxes next to the items that you want to appear on your map. Once you have checked what you want, click Submit.